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Introduction 
Welcome to Colligo Contributor Add-in for Outlook, the simple and effective way to increase adoption of 
SharePoint for email and attachment management. It delivers a cost effective and intuitive way to 
upload content to SharePoint and browse document libraries and lists — all from within the Microsoft 
Outlook interface. Users can click the Send & File button or simply drag-and-drop emails and 
attachments into document libraries and folders, instantly capturing critical metadata. The built-in 
Attachment Manager easily stores email attachments in SharePoint, replacing them with links.  

Benefits 
 Empower users to easily manage email and documents in SharePoint 
 Increase the quantity of content captured and tagged in SharePoint 
 Make SharePoint accessible directly from Outlook 
 Drive mobile and remote workforce productivity with easy offline access 
 Improve collaboration, and document project management 
 Reduce risk and improve compliance 

Key Features 
 Save content to SharePoint libraries with metadata prompt and automatic extraction of email 

metadata 

 View SharePoint content in Outlook, online and offline  

 Navigate through SharePoint site using the Outlook folder tree 

 Update documents from Outlook folders 

 Use content types and forms in Outlook 

 Set content types for list items 

Platforms Supported  
 Microsoft SharePoint Server 2010, MOSS 2007, SharePoint Portal Server (SPS) 2003 

 SharePoint Foundation Microsoft Windows SharePoint Services (WSS) 3.0, or 2.0 

 SharePoint 2010 Online (Office365) 

 SharePoint 2013  

 Outlook 2007, 2010, 2013 Preview (32-bit and 64-bit) 

 Windows XP Professional, Windows Vista, Windows 7, Windows 8 

NOTE: The screenshots in this document use Outlook 2010, SharePoint 2010, and Windows 7. Your user 
interface may differ depending on your specific configuration. 
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Installing and Activating Contributor Add-in for Outlook 
NOTE: Microsoft Outlook must be closed for the installation to be successful.  

To install and activate Contributor Add-in for Outlook: 
1. Double-click to open the zip file and extract the contents.  
2. In the folder, double-click the folder that corresponds to your operating system:  

a) x64: choose this option if you have a 64-bit operating system 
b) x86: choose this option if you have a 32-bit operating system 

3. Double-click either Setup.exe or .msi.  
4. Follow the steps in the install wizard.  
5. After the install is complete, the following dialog displays:  

 

6. Enter your information and click Activate. If you do not activate Colligo Contributor Add-in for 
Outlook, the add-in does not display.  

After Contributor Add-in for Outlook is installed, a new group called Colligo for SharePoint displays 
in the Outlook folder tree and in the Home ribbon:  

 

 

You can now connect SharePoint lists and libraries to your Outlook folder tree. 
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Activating Contributor Add-in for Outlook Manually  
If you are unable to connect to the activation server, the following error message displays:  

 

Click Activate via Email to create an activation request file. The following dialog displays: 

 

Click Export Activation Request. This creates a .txt file that you can save anywhere on your machine, 
and then attach to an email that you can send to Colligo to request a manual activation.  
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Using the Contributor Add-in for Outlook Control Panel 
The second interface component of Contributor Add-in for Outlook is called the Control Panel. This 
interface allows you to set your synchronization settings, and view any Sync Issues.  

 

Checking for Updates 
In the Add-in Control Panel, you can check if you are using the most current version of Contributor Add-
in for Outlook. Click the Help menu and select Check for Update. 

The www.colligo.com site launches in your web browser. If there is a newer version available, click the 
Download the latest version now link to install the newer build. 

Updating Your License Key 
In the Add-in Control Panel, you can change your license key. Click the Help menu and select Install 
License Key.  

The Enter License Key dialog displays. Enter your new license key and click OK.  
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Adding SharePoint Lists and Libraries to Outlook 
You can add a SharePoint list or library to Contributor Add-in for Outlook in one of two ways: 
1. By using the SharePoint Sites dialog in Outlook. 
2. By using the Connect to Outlook button in Internet Explorer. 

Using the SharePoint Sites dialog in Outlook 
To connect a site from within Outlook: 

1. Click the Download icon in the Colligo For SharePoint group in the Home ribbon in Outlook.  

 

The Connect Document Library dialog displays: 

 

2. Click Download new site.  
The Download New Site dialog displays: 

 

3. Enter the URL of the site and use your default credentials, or user-specific credentials.  
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4. Click Download. The site displays in the Connect Document Library dialog. 
5. Click Next. A list of all lists and libraries in the site displays: 

 

6. Select the list or library you want to display in Outlook. If you want the list or library to be cached 
(available offline) check the Enable local caching for this list or document library box.  

7. Click Finish. The list or library displays in the Colligo for SharePoint list in your Outlook folder tree.  
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Using the Connect to Outlook Button in Internet Explorer 
You can add a SharePoint list or library to Contributor Add-in for Outlook directly from Internet Explorer 
using the Connect to Outlook button. 

To add a site with the Connect to Outlook button: 
1. Navigate to the SharePoint list or library that you want to add as a folder in Outlook, and click the 

Connect to Outlook button: 

Internet Explorer 9 

 

NOTE: If the Connect to Colligo Outlook button is not visible, you need to enable the Command bar. 

Internet Explorer 8 

 

The following dialog displays: 

 

2. Check the Enable local caching for this list or document library box if you want the list or library to 
be cached (available offline). 

3. Click Yes. The list or library displays in the Colligo for SharePoint list in your Outlook folder tree. 

NOTE: If you click the Connect to Outlook button when you’re on a SharePoint page that is not a list 
or library, the following message displays:  
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Click OK, then navigate to a list or library in Internet Explorer and click Connect to Outlook again. 

Viewing Lists and Libraries in Outlook  
Click on an Outlook folder under the Colligo for SharePoint group to display the selected SharePoint 
location.  

The folder location displays in one of two modes: Cached or Online. 

Cached View 

 

Online View 

 

Online mode and cached mode have similar functionality, except that for the online view, the content is 
not cached (available offline). Both modes allow you to do the following: 

 Upload content to SharePoint with metadata Prompt 

 View the SharePoint site in Outlook 

 Automatically extract Email metadata (To, From, Sent, Subject, etc.) 

 Access and Edit existing SharePoint content including accessing metadata. 

To refresh the content, click the Refresh Folders icon in the Colligo For SharePoint group in the Home 
tab in Outlook.  
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Configuring your Synchronization Settings 
The settings for how frequently your content is synchronized are set in the Control Panel.  

1. From the View menu, select Options. 
The Colligo Contributor Options dialog displays: 

 

2. In the General section, you can turn on the prompt to record properties about the document by 
checking the Prompt for properties when adding documents box. You can override this setting for 
specific lists/libraries when you are configuring Default Metadata; see Setting Default Metadata. 

3. In the Synchronization section, choose your preferred options: 
a. Synchronize on startup: choose this option if you want your lists and libraries to synchronize 

every time Outlook starts  
b. Synchronize when list is viewed: choose this option if you want your lists and libraries to 

synchronize every time a list or library is viewed 
c. Synchronize when list is modified: choose this option if you want your lists and libraries to 

synchronize every time a list or library is modified 
d. Enable background synchronization: choose this option if you want to set the 

synchronization to happen in the background on a time-specific basis, and enter your 
preferred time interval 

e. Automatically download lists to resolve Site Column values: if you have lists that reference 
other lists (look-ups), checking this option ensures the related referenced lists are also 
downloaded 

NOTE: Depending on how your IT Administrator has configured the installation, this dialog may not be 
accessible to you, or the synchronization options may be greyed out. 
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Synchronizing Content Manually 
To manually synchronize your SharePoint content: 

1. Click the Synchronize icon in the Colligo For SharePoint group in the Home ribbon in Outlook:

 

The Synchronize SharePoint Content dialog displays: 

 

2. Check the boxes of the sites you want to synchronize, or use the Check All or Uncheck All buttons to 
set your preferences.  

3. Click Synchronize. 

Completing a Full Synchronization 
Several of the synchronization dialogs have a Perform Full Synchronization option. A full 
synchronization downloads additional information. This includes definitions for Sites, Lists, Views, and 
Content Types, plus other site content that may not be retrieved during other standard sync processes. 
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Filing Items to SharePoint Folders 
You can file emails and documents to your SharePoint folders in Outlook in a number of different ways.  

Dragging-and-Dropping Emails 
You can upload one or multiple emails to SharePoint by dragging-and-dropping them from your inbox to 
a SharePoint location in your Outlook folder tree. You can also drag-and-drop other documents from 
your desktop or a Windows Explorer folder location.  

Each time you file something to a SharePoint folder in Outlook, the metadata editor displays: 

 

Edit the metadata fields as preferred and click Create to complete the upload process.  

Move Versus Copy 
When you drag-and-drop an item into a folder, it is either moved or copied to SharePoint. If it’s moved, 
the email no longer exists in your Outlook. If it’s copied, it exists both in SharePoint and in Outlook.  

The default behavior when using the drag-and-drop action is Move. If you want to Copy the item to 
SharePoint, you can do one of the following: 

 left-click and press Ctrl until you let go of the click  

 right-click: when you let go of the click, the following dialog displays, giving you the option to Copy 

 

NOTE: attachments are copied to SharePoint and remain as part of the email. 
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Sending-and-Filing Emails 
When you’re creating a new email, you can use the Send & File button to send your email and file it at 
the same time. 

1. Click the Send & File button, the Colligo Send & File dialog displays: 

  

2. Browse to the location you want to file the email to and double-click to select the folder and send 
the email.  
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Using the Copy Folder 
You can upload whole folders and their contents (including subfolders) from your mailbox to SharePoint.  

1. Click the Copy icon in the Colligo For SharePoint group in the Home ribbon in Outlook: 

 

The Copy Outlook Folder dialog displays: 

 

2. In the Select Folder to Copy panel, choose the folder that you want to copy to one of your 
SharePoint locations.  

3. In the Select Destination panel, choose the SharePoint location to copy the folder to.  
4. In the Copy Options section, choose if you want to include the top-level folder and/or any 

subfolders. 
5. Click OK.  
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Working with Content in Cached Mode  
Many SharePoint actions are available in the cached (offline) mode. 

Right-click on an item to: 

 Edit the properties  

 Open/Edit  

 Check Out, Check In, or Discard Check Out 

 Rename content 

 Delete content 
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Creating New Content  
To create new content in a cached folder: 
1. Click the New drop-down menu: 

 

2. Select the New Document option to display the Create New Document dialog: 

 

3. Choose your document type from the Site Templates tab or the Other tab. 
4. Enter a name for the document, and click Create.  
5. The Edit Properties dialog displays. Edit as preferred. 

The new document is added to the list or library. 
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Uploading Existing Content 
To upload existing content to a cached folder: 
1. Click the Upload drop-down menu and select Upload Documents: 

 

The Upload Documents dialog displays. 
2. Browse to the location of the document you wish to upload and click Open.  
3. The Edit Properties dialog displays. Edit as preferred and click Create.  

The new document is added to the list or library. 
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Setting Default Metadata 
If you want to tag all documents and items that you add or upload to a list or library with the same 
metadata, you can set default metadata values through the Control Panel: 

1. From the Control Panel File menu, choose Default Metadata Values.  
The Default Metadata Values dialog displays:  

 

2. Select the site and library/list that you want to configure.  
3. To add a metadata tag, click Add.  

The Add Default Meta data Properties dialog displays, displaying the metadata field options that 
are set in the document library in SharePoint.  

 

4. Enter your preferred tags and click Add.  
5. If you want the values to propagate to any subfolders, check the Propagate these default metadata 

values to subfolders box.  
6. To configure the behavior or the prompt to record document properties, choose a radio button on 

the right under the When adding documents, prompt for properties section: 

 Always 

 Never 
According to application global settings (as set in step 2 of Configuring your Synchronization 
Settings)  



  Colligo Contributor Add-In for Outlook 

12/02/2013 Copyright 2013 Colligo Networks, Inc. All rights reserved. 
Not to be reproduced without permission. Learn more at www.colligo.com. 

Page 19 of 22 

 

Using the Colligo Attachment Manager 
Colligo Contributor Add-in for Outlook has an Attachment Manager tool that gives you a number of 
ways to share and manage your SharePoint content. 

Uploading an attachment to SharePoint 
If you want to send someone a document, but you would rather send a link to a SharePoint location 
instead of an attachment, you can upload the document to SharePoint and insert a link to the location 
into your email. You can do this from Outlook using Colligo’s Attachment Manager.  

When you launch a new email, the Colligo Attachments group displays in the Message ribbon: 

 

NOTE: The Colligo Attachments group only displays in the Message ribbon of a new email; it does not 
display anywhere else in Outlook.  

1. Click Upload to display the Upload Attachments to SharePoint dialog:  
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2. In the Choose Files section, click Add and browse to the location of the document(s) you want to 
upload. 

3. In the Destination Site section, click Choose Destination and select the Site, Library, and Folder you 
want to upload your documents to.  

4. Click OK. The New Item dialog displays.  
5. Enter any properties and click Create.  

The document is uploaded to your specified location, and a link to the document’s location is inserted 
into the body of your email:  

 

Inserting a Link to a Document in SharePoint  
If the document you want to share is already in SharePoint, you can insert a link to the document in your 
email,  

To insert a link to an item in SharePoint: 

1. Click Insert in the Colligo Attachments group in the Message ribbon and choose either Attachment 
Link or Text Link.  

NOTE: The Attachment link displays the full path of the SharePoint location, while the Text link 
displays only the name of the file.  

The Link to SharePoint Content dialog displays: 



  Colligo Contributor Add-In for Outlook 

12/02/2013 Copyright 2013 Colligo Networks, Inc. All rights reserved. 
Not to be reproduced without permission. Learn more at www.colligo.com. 

Page 21 of 22 

 

 

2. Browse through the SharePoint libraries to find the document you want to link to, and click Insert.  

The links display as follows: 
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Setting Attachment Rules 
You can configure rules for the size of your attachments that correspond to your organization’s email 
policies to display a prompt when you have an attachment exceeding a certain size, or to block sending 
an email when an attachment exceeds a specified size.  

To configure the rules: 
1. Click Rules in the Colligo Attachments group to display the Colligo Attachment Manager dialog: 

 

2. In the field Prompt when sending emails with total attachment size great than (Kb), enter the limit 
for the size of the attachment. If you attempt to send an email that has an attachment greater than 
the number you have specified in this field, the following dialog displays: 

 

Choose from one of the following options: 
a) Send Anyway: choose this option to ignore the warning and send the email as configured 
b) Upload to SharePoint: choose this option to display the Upload Attachments to SharePoint 

dialog and choose the location in SharePoint you want to upload the attachment to 

3. In the field Block when sending emails with total attachment size great than (Kb), enter the limit 
for the size of the attachment. If you attempt to send an email that has an attachment greater than 
the number you have specified in this field, the following dialog displays: 

 

4. Click OK and the Upload Attachments to SharePoint dialog displays.  
5. Choose the upload destination and click OK. The item is uploaded and a link to the SharePoint 

location is inserted into your email. 


